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Title of equipment: UV direct writer 

Model: UVW03 

 

Product Description: 

This product is a device for micro-lithography that uses a UV laser beam to draw patterns. It 

supports both raster scanning by loading image files to be used as masks and vector scanning, 

where the laser follows lines drawn with a mouse. It is utilized in maskless lithography processes 

using positive photoresists (PR) for the fabrication of research-scale semiconductor devices, such as 

chips with dimensions of several centimeters. The device is applicable for manufacturing various 

research devices, including semiconductor devices, solar cells, and water-splitting devices. 

Product Dimensions: 

Width: 28 cm x Depth: 36 cm x Height: 47 cm 

 

Hardware Description: 

(Light Source): The device is built using a 405 nm laser diode. The light intensity is feedback-

controlled based on the photocurrent 

value measured by the built-in 

photodiode. The laser power is designed 

to reach up to 500 µW.  

(Front of the Device): At the front of the 

device, there is a sample stage 

connected to the scanner, with a 

microscope objective lens mounted 

above it. The objective lens can be 

rotated either manually or automatically 

to select magnifications of 5x, 10x, 20x, 

50x, or 100x. Similar to a standard 

optical microscope, users can observe 

the substrate at low magnification and 

gradually move to higher magnifications 

to precisely determine the areas for patterning. 

Figure 1: Mount for Sample Wafer Installation and 

Objective Lenses 
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(Rear of the Device): The back of the device features a power switch and a USB connector. The 

USB connector must be connected to a USB 3.0 port on the control PC (USB 2.0 is insufficient for 

camera operation). 

Sample Substrate Installation: 

This product uses a red LED illuminator to observe the substrate without exposing the photoresist 

to light. For research device fabrication, wafer substrates of 1-2 cm in size are placed in the center 

of the stage. A rectangle is marked on the sample stage, and the sample should be positioned so 

that the area to be patterned lies within this rectangle. 

 

Wafer Size: 

This product allows patterning up to a maximum size of 25 mm and provides a spacious stage 

capable of accommodating substrates larger than 5 cm. A square area is marked on the black stage, 

indicating the region where the laser beam can write. With a z-axis adjustment range exceeding 1 

cm, the device is compatible with wafers of varying thicknesses. For wafers of different thicknesses, 

users can initially set a rough focus at low magnification and gradually shift to higher magnifications 

for precise focusing. 

XY Positioning of the Sample: 

To align the desired area of the sample with the laser focus, first activate the illuminator by pressing 

the "Illuminate On" button in the app's right-hand menu. Once the illuminator is turned on, a red 

light will project onto the sample surface through the objective lens. Position the area to be 

patterned within this red-illuminated spot. 

Sample movement is controlled via the keyboard or app menu. Using the arrow keys on the 

keyboard moves the stage in 100-micrometer increments. For instance, pressing the right arrow key 

shifts the sample to the right, causing the image on the screen to move accordingly. (Refer to the 

app menu for shortcut key locations and customization options.) 
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Right-Side Shortcut Buttons:  

(Camera Capture) Pressing the "Camera Capture" button temporarily 

turns on the illuminator, captures a microscope image, displays it on 

the screen, and then automatically turns off the illuminator. This 

function minimizes exposure to prevent PR damage while observing 

the sample. 

(Wide View): The "Wide View" button allows users to observe a larger 

area. It moves the scanner to collect nine surrounding images and 

stitches them together to display a wide-field image of the substrate. 

(Video On/Off) Pressing the "Video On" button displays real-time 

video from the camera mounted on the microscope in the main 

window. Pressing the "Video Off" button stops the live video feed. 

(Objective Lens): Buttons for selecting objective lenses with 

magnifications of 5x, 10x, 20x, 50x, and 100x are provided. Pressing a 

button automatically switches to the selected lens. The scale bar and 

screen position adjust accordingly to maintain the center of the field 

of view. 

*** Alignment Tip: 

To align a large area down to a central fine region during the 

writing process, start with the 5x objective lens and 

sequentially switch to higher magnifications (10x, 20x, 50x, and 

100x). At each magnification, center the field of view and 

capture an image. At 100x magnification, use zoom-in/out to 

align the mask image with the captured images corresponding 

to each zoom level. This process simplifies the alignment 

workflow by displaying the mask image alongside the 

captured images on the screen. 

 

(Writing Area): The numbers displayed in the "Writing Area" 

window represent the maximum pattern size. This value can be 

adjusted by accessing the Writing Configuration menu. 

Figure 2: Right-Side Menu 

Panel of the Main Window 
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(Laser): In the input field, users can set the laser intensity by entering a value between 0.1 and 5. 

Pressing the "On" button activates the laser, while pressing the "Off" button deactivates it. 

(Illuminate): The "On" button turns on the red LED light connected to the objective lens, allowing 

the observation of the sample surface. Pressing the "Off" button switches off the illumination. 

(Focus): Pressing the "Focus" button initiates an automatic focusing process. During this process, 

the z-axis motor moves to adjust the focus, which can be monitored through the display.  

 

<Focusing Procedure> 

Focus Adjustment Using "Laser" and "Sample" Buttons: 

Located next to the "Focus" button, the "Laser" and "Sample" buttons help streamline the 

focusing process by allowing users to visually fine-tune focus directly on the screen. 

"Laser" Button: 

Pressing the "Laser" button shifts the z-axis value in the positive direction by the amount 

specified as (laser focus from sample focus) in the Objective Lens menu. 

The laser automatically turns on at an initial intensity of 0.1 V, and the camera exposure time is 

reduced to make the laser beam easier to distinguish. 

Adjust the z-axis value until the laser focus appears smallest (sharpest) on the screen, and note 

this optimal laser focus position, z_laser. 

"Sample" Button: 

Pressing the "Sample" button shifts the z-axis value in the negative direction by the same 

amount (laser focus from sample focus) specified in the Objective Lens menu. 

The laser automatically turns off, and the camera exposure time increases to make the sample 

more visible. 

Adjust the z-axis value until the sample appears clearest, and note this optimal sample focus 

position, z_sample. 

Verification and Calibration: 

Calculate the difference: z_sample - z_laser. 

Verify that this value matches the "laser focus from sample focus" value set for the specific 

objective lens in the Maintenance -> Objective Lens menu. 

If there is a discrepancy, update the setting in the menu to reflect the correct value. 

Automatic Integration in Writing Process: 

Once the "laser focus from sample focus" value is set, it will be automatically applied during the 

writing process to ensure optimal focusing without manual adjustments. 
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Features and Operations 

Position Display and Adjustment: 

• The "Position (um)" window displays the current motor positions for X, Y, and Z axes in 

micrometers. 

• Enter a value in the input field and press Enter to move the motor to the specified position. 

• When moving along the Z-axis, ensure there is enough clearance between the objective 

lens and the sample. 

• Z-Axis Adjustment Buttons: 

o The "+" and "–" buttons next to the Z position field allow movement in 1 µm 

increments. 

o Using the keyboard arrow keys moves the stage in 100 µm increments. 

o Page Up and Page Down keys move the stage in 10 µm increments along the Z-

axis and will continuously move if held down. 

Notification and Progress Windows: 

• Information Window: Displays the current operational status of the app. 

• Progress Window: Shows the progress of the patterning process. 

• Time/Estimated Window: Displays the elapsed time for the scan and the estimated total 

duration. 

Blink Function: 

• Press the Blink button to toggle the laser on and off for the specified duration. 

• This feature is useful for testing laser intensity or drawing single points. 

Draw Line Tool: 

• Buttons labeled 1, 3, 6, 10 and an Erase button are provided for vector line drawing.  

o The numbers represent line widths in micrometers. 

• To draw:  
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1. Select a line width button. 

2. Left-click on the desired starting point in the microscope image. 

3. Move the mouse and click on the next point to draw a straight line. 

4. Continue clicking for a polyline. 

5. Right-click to finish the drawing. 

• To erase lines, click the Erase button and then click on the unwanted lines. 

• When you click the Move button and drag the screen with the mouse, the lines move 

together. 

Mask Pattern Loading: 

• Show Button: Displays a composite view of the captured microscope image, loaded mask 

pattern, and drawn lines. 

• All Button: Similar to the Show Button, but zooms out to display the entire writing area. 

• Zoom In/Out Buttons: Adjust the view incrementally. 

• Mask Button: Loads a mask image from the PC and displays it on the screen. To replace 

the mask, use the Image menu under the File menu. To erase the mask, use the Erase 

Mask option in the Raster Scan menu. 

Camera Configuration: 

• Gain and Expo.: Adjust the camera's gain and exposure time.  

o While observing the sample, these settings are set to Auto and may change 

dynamically. 

o For laser focusing, set these values to their minimum defaults for clearer focus 

visualization. 

• Camera Control "Auto" Button: Automatically adjusts the gain and exposure time, typically 

used for monitoring the sample surface. 

Movement Buttons: 

• The bottom of the right menu contains buttons for moving in the +X, -X, +Y, -Y, +Z, and -

Z directions. 
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• Each click moves the stage by 10 µm. Holding a button continuously moves in the 

corresponding direction. 

Start Writing: 

• Press the Start Writing button to begin patterning. 

• To stop the process, press the button again or left-click anywhere in the main window. 

• A confirmation message will appear, allowing the user to decide whether to stop or continue. 

• Upon completion or interruption, the screen image is automatically saved. 

 

 

Figure 3: Composite View Displayed After Pressing the Show All Button 

When the Show All button is pressed, the screen displays a composite view that overlays the 

mask pattern, captured microscope image, and drawn lines, allowing users to view all elements 

on a single screen for alignment and review. 
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Menu Description: 

File Menu: 

• Import CAD file: Load a saved pattern image from the PC. 

• Import Image: Load a saved pattern image from the PC. 

• Import Alignment Mark: Load alignment marks from saved files. 

• Import Line Pattern: Retrieve previously saved line patterns if line drawing was performed 

earlier. 

• Save Image: Manually save the current pattern to a file.  

o Note: Even if this option is not selected, the pattern image is automatically saved 

after drawing. 

 

 

Automatic Data Saving: 

• After completing a pattern, a folder named with the current date and time is automatically 

created within the desktop's Data folder. 

• All measurement data is saved automatically in this folder upon completion. 

Figure 4: File Menu Functions 

The File Menu allows users to: Use "Import Image" and "Import Alignment Mark" to load 

saved patterns from the PC. Select "Save Image" to save the current pattern for future 

use. 
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CAD Pattern 

Creating CAD Files: 

Users can create CAD files using external CAD software (such as AutoCAD). Objects may be drawn 

using polylines or lines. 

• A polyline is treated as an area (filled region) if it forms a closed shape. 

• A line is treated as a simple line-drawing element. 

If the vertices of a polyline are drawn in a counterclockwise direction, the region is interpreted as 

an inner filled area. 

If they are drawn in a clockwise direction, the region is interpreted as an outer boundary. 

Therefore, to draw a donut-shaped object, the outer contour should be drawn in a 

counterclockwise direction, and the inner contour should be drawn in a clockwise direction. 

The file should be saved in DXF format. 

A CAD file created in an external program can be loaded through the File menu of this software. 

When filling an area, this system always uses a circular mode, starting from the outer boundary 

and proceeding inward along the contour. 

To verify whether the area is filled as intended, it is recommended to run a simulation (Simulate) 

before starting the actual 

writing process. 

 

 

(Drawing Configuration) 

Each Configuration menu for 

CAD patterns, image-based 

patterns, and vector line 

patterns allows users to 

modify writing conditions 

and the overall settings of 

connected devices. 

CAD-related settings can be 
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adjusted under: 

CAD Writing → CAD Writing Configuration 

 

CAD Layer Writing 

When entering the CAD Writing Configuration menu, the following window appears. 

• Line Spacing for Filling Area: 

This parameter defines the spacing between adjacent scan lines when filling an area. 

The default value is 1 µm. 

• Layer Configuration: 

The system supports four layers: 

o Layer0 (Red) 

o Layer1 (Yellow) 

o Layer2 (Cyan) 

o Layer3 (Blue) 

When creating CAD files in external software, users can assign different objects to different layers. 

These layers are displayed on the screen in their respective colors, and writing conditions can be 

configured separately for each layer. 

 

Writing Speed 

Writing speed refers to the velocity at which the laser focus moves. 

To obtain different line widths: 

• Thin lines can be produced using a higher scanning speed. 

• Thicker lines can be produced using a slower scanning speed. 

Since this value depends on the thickness and characteristics of the photoresist, users should 

experimentally determine and adjust the optimal value. 

For Layer0, Layer1, Layer2, and Layer3, writing speed can be individually adjusted using the 

corresponding input fields. 
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Using external CAD software such as AutoCAD, users can draw polylines, rectangles, circles, and 

ellipses and assign each object to a specific layer. 

Each layer is displayed on the screen in its designated color (red, yellow, cyan, blue), and the writing 

process is executed based on the parameters assigned to each layer. 

 

Laser Intensity 

For Layer0, Layer1, Layer2, and Layer3, laser intensity can be individually adjusted using the 

corresponding input fields. 

Users can assign CAD objects and fine structures to specific layers using external CAD software (e.g., 

AutoCAD). 

Each layer is displayed on the screen in the designated color order (red, yellow, cyan, blue). 

Based on these layer-specific input values, the exposure (or marking) process is carried out. 
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Image Pattern 

Image Writing (Raster Writing) 

Image patterns are drawn by loading an image file through the File menu and writing the pattern 

contained in the image. 

Since the black regions of the image are filled using a raster scanning method, this process is 

referred to as Raster Writing. 

Raster Writing refers to a writing process in which areas are filled, rather than individual lines being 

traced. 

The Raster Writing menu includes functions for loading a mask pattern and previewing the target 

pattern. 

The Find Edges function detects the boundaries of patterns and allows users to verify the grouping 

process through Grouping. 

By using Simulate Writing, users can preview the expected writing result, and a final preview is 

available through Final Pattern. 

All of these steps are automatically performed during the Writing process, so users do not need to 

manually check each step. 

If the currently loaded image is not satisfactory, selecting Erase Mask Pattern will remove the 

loaded mask image. 

 

 

Figure 5. Image Writing → Raster Configuration menu, where image pattern parameters can be 

configured. 

 

Writing Configuration 
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When the Writing 

Configuration menu is 

selected, a configuration 

dialog appears. 

• Writing Area: 

In the Writing Area 

combo box, users 

can select the side 

length of the square 

writing area. 

Typically, a size of 4–

5 mm is 

recommended to 

include contact pads 

for chip-scale devices. 

Selecting a larger writing area allows fabrication of larger devices, but increases the writing 

time. 

• Step Size and Resolution: 

The step size corresponds to 1/1000 of the selected writing area, and this value 

determines the resolution of the image-based raster scanning pattern. 

The magnification factor is automatically determined based on this value. 

•  

 

Laser Intensity 

Laser intensity can be configured separately for two regions: 

1. Inside (Central Area Filling): 

When filling the central region, a moderate laser power is used to achieve fine patterning. 

This default value is shown in the Inside input field. 

2. Outside (Peripheral Area Filling): 

When filling the outer region, a higher laser power is used with a wider line spacing to 
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enable faster writing. 

The corresponding value is shown in the Outside input field. 

 

Writing Speed 

Writing speed refers to the velocity of the laser focus movement. 

1. Inside: 

The writing speed for filling the central area is displayed in the Inside field. 

2. Outside: 

The writing speed for filling the outer area is displayed in the Outside field. 

 

Raster Writing Configuration 

In the Raster Writing menu, the loaded image can be removed by selecting Erase Mask Pattern. 

When Raster Writing Configuration is selected from the Raster Writing menu, a configuration 

dialog similar to the one shown above appears. 

• Outside Low Resolution for Fast Writing: 

When this option is enabled, the system divides the pattern into a central region and an 

outer region and applies different resolutions during writing. 

This function improves writing speed by rendering the central region at maximum resolution 

while writing the outer region at a lower resolution. 

• Outside Portion: 

The percentage of the pattern area treated as the outside region can be specified. 

• Outside Subfactor: 

This parameter defines how many micrometers correspond to a single pixel in the outside 

region. 

A larger value results in a sparser writing pattern with lower resolution. 

• Outside Defocus: 

This parameter specifies how far the focal plane is shifted from the optimal focus when 

writing the outer region at lower resolution, 

allowing a larger laser spot size for faster area filling. 
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Line Drawing (Line Drawing Mode) 

Vector Writing refers to a writing method in which patterns are created by drawing individual lines. 

By selecting Vector Writing → Line Writing Configuration, users can configure the parameters for 

line drawing. 

 

 

Figure 10. Vector Writing menu, where starting, stopping, and deleting drawn lines can be 

performed. 

 

When the Line Drawing Mode checkbox is enabled, patterns can be created by drawing lines 

directly using the mouse. 

In vector scanning based on mouse-drawn lines, the writing process is not limited by raster 

resolution. 

When drawing lines, different laser intensities can be selected depending on the desired line width: 

• Lower laser intensity is used for thin lines. 

• Higher laser 

intensity is used for 

thicker lines. 

 

Line widths are divided into 

four levels—1, 3, 6, and 10 

µm—and default speed 

values are displayed for each 

level. 

Please note that the values 1, 

3, 6, and 10 µm represent 

visual line thicknesses 



17 

 

displayed on the screen for user convenience and are not directly related to the actual 

fabricated line width. 

Since the actual line width depends on the thickness and characteristics of the photoresist, users 

may adjust these values to determine appropriate settings. 

 

When drawing lines, different writing speeds are applied according to line width: 

• Thin lines are scanned at a higher speed. 

• Thick lines are scanned at a lower speed. 

Default speed values are provided for the four line-width levels (1, 3, 6, and 10 µm). 

As with laser intensity, these values depend on the photoresist properties and may be adjusted by 

the user. 

 

Delete All Lines is used to remove all lines drawn on the screen. 
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Device Configuration 

• (Arduino Port Number): 

When the Arduino processor is properly connected, the Connected indicator is checked. 

If the connection is not established and the Arduino processor needs to be reconnected, 

the correct COM port number must be identified. 

To do this, open Windows Device Manager and check the port number assigned to the 

Arduino device under the Ports section. 

Enter the correct port number and click the Initialize button. 

If the connection is successful, the Connected indicator will be checked. 

 

• MCU for Scanner Motor Control: 

The system includes an embedded MCU to drive the scanner motor. 

If the motor temporarily stops moving, disconnect and reconnect the USB cable, then click 

the Initialize button to re-establish the connection. 

 

• Camera Initialization: 

If a temporary error 

occurs with the Basler 

camera, clicking the 

Camera Initialize button 

will reset and restart the 

integrated camera. 

• Current Position: 

Displays the current X 

and Y positions of the 

scanner. 

• Laser Position: 

Indicates the position of 
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the laser focus. 

Although an optimal value is set at the time of shipment, the laser focus position may drift 

over time. 

Therefore, it is recommended to recalibrate the laser position once every month. 

When the laser is turned on while the sample is in focus, the laser may appear excessively bright, 

making it difficult to identify the focal center on the screen. 

In this case, reduce the Camera Gain to locate the focal center more clearly, then right-click the 

mouse to save the position. 

• Step Motion: 

The +X, +Y, −X, −Y buttons move the scanner in each corresponding direction by the 

distance specified in the central input field. 

After setting the desired values, click the Set button to save the configuration, and then 

click Close to finish. 
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Mouse and Keyboard Control 

(Mouse Operation) 

By dragging the mouse to draw a rectangular selection on the camera image, the selected region 

is set as the scan area. 

When a single point is left-clicked with the mouse, a message dialog appears. 

• If Yes is selected, the clicked point is moved to the center of the screen. 

• If No is selected, the clicked point is moved to the laser focal position. 

 

(Keyboard Operation) 

• The Left and Right Arrow keys move the sample along the X-axis. 

Each key press moves the sample by 100 µm. 

• The Up and Down Arrow keys move the sample along the Y-axis. 

 

Laser Focus Adjustment 

Although an optimal laser focus position is set at the time of shipment, the position may drift over 

time. 

Therefore, it is recommended to recalibrate the laser focus once every month. 

When the laser is turned on while the sample is in focus, the laser may appear excessively bright, 

making it difficult to identify the focal center on the screen. 

In this case, reduce the Camera Gain to darken the overall image and clearly identify the focal 

center. 

When the focal center is right-clicked with the mouse, a dialog appears asking whether to update 

the focus position. 

Selecting Yes stores the new laser focus position. 

Once saved, the focus position is retained even after restarting the PC, and it can be updated again 

at any time. 

 

Mask Align Menu 
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When a mask is loaded, as shown in Figure 11, the mask pattern appears at the center of the screen 

along with three icons on the right side: 

1. Move Icon (  ) 

Used to move the mask position. 

Clicking the icon once turns it red. 

In this state, clicking and dragging anywhere on the screen moves the mask. 

2. Rotate Icon ( ) 

Used to rotate the mask about the X–Y axes. 

After clicking the icon and turning it red, dragging the mouse rotates the mask in the 

direction parallel to the mouse movement. 

3. Scale Icon (  ) 

Used to increase or decrease the mask size. 

After clicking the icon and turning it red, dragging the mouse scales the mask in the 

direction parallel to the mouse movement. 

These functions are primarily used to precisely align the mask after capturing a camera image. 

To verify the alignment, rotating the mouse wheel zooms the entire image in or out, allowing fine 

adjustment of the alignment. 
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Figure 11. Default main window of the UVW.exe application: 

A low-magnification (5×) microscope image is displayed at the center of the screen, with control 

menus on the right side. 
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Maintenance Tools Menu 

 

Stage Tilt Correction 

This function compensates for focus deviation during large-area writing caused by tilt of the sample 

stage or the sample itself. 

While observing the live image on the screen, first adjust the focus accurately and then click the 

Point 1 button. 

The (x, y, z) coordinates of the current position are stored. 

Next, move a sufficient distance (at least 5 mm) along the X-axis, adjust the focus again, and click 

the Point 2 button. 

The coordinates of the second point are then stored. 

Then, move a sufficient distance (at least 5 mm) along the Y-axis, adjust the focus, and click the 

Point 3 button. 

The coordinates of the third point are stored. 

Once all three coordinates are defined, click the Set button. 

The system calculates and stores the tilt values (X tilt and Y tilt). 

Finally, enabling the Tilt Correction While Writing option applies tilt compensation automatically 

during the writing process. 

This function is not necessary for small writing areas, but is recommended when performing high-

precision writing over large areas (5 mm or larger). 
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Figure 12. Stage Tilt Correction dialog under the Maintenance Tools menu. 

 

Stripe Pattern Test 

Achieving narrow line widths critically depends on precise focusing. 

However, the focus observed in the camera image may not always coincide with the actual focal 

position of the laser beam on the photoresist (PR). 

For this reason, the Stripe Pattern Test in the Maintenance Tools menu is provided to determine the 

Z position that produces the minimum line width. 
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Figure 13. Stripe Pattern Test dialog in the Maintenance Tools menu. 

 

In the dialog box, the parameters are defined as follows (from the upper-left corner): 

• Number of Lines: Number of lines to be written 

• Pitch: Spacing between adjacent lines 

• Speed: Writing speed 

• Laser Int.: Laser intensity 

• Length: Line length 

• z₀ (µm): Starting Z position 

• Z-step: Z increment between successive lines 

With these parameters set as shown and the Start button pressed, lines are written sequentially 

from bottom to top at Z positions relative to the current Z value 

(e.g., −5.0, −4.5, −4.0, …, +4.5 µm). 

After developing the sample, stripe patterns appear from bottom to top. 

By identifying the Z position that yields the narrowest line width, the optimal focus offset can be 

determined. 
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This value should be entered into the “Laser Focus from Sample Focus” field in the Objective Lens 

dialog under the Maintenance Tools menu. 

During writing, the system automatically applies this offset for focus correction. 

Alternatively, the Defocus value in the Configuration dialog can be adjusted. 

The effective Z adjustment during writing is the sum of the “Laser Focus from Sample Focus” 

value and the “Defocus” value. 
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